# Table of contents

1. **Introduction** ........................................................................................................ 13
   1.1 Manufacturer ................................................................................................. 13
   1.2 Subject to change ......................................................................................... 13
   1.3 Completeness ............................................................................................... 13
   1.4 Supporting documentation .......................................................................... 14
   1.5 Storage site ................................................................................................... 14
   1.6 Illustration conventions ................................................................................ 14
      1.6.1 Abbreviations used .................................................................................... 15
      1.6.2 Information concept ................................................................................ 16
      1.6.3 Typographic conventions ....................................................................... 16

2. **Installation** ....................................................................................................... 17
   2.1 Typical installation ....................................................................................... 17
   2.2 Custom installation ....................................................................................... 18
   2.3 Selecting device ............................................................................................ 20

3. **Product description** ....................................................................................... 23
   3.1 Scope of delivery .......................................................................................... 23
   3.2 Basic tasks of visualization software ......................................................... 24
   3.3 Description of basic structure ....................................................................... 26
   3.4 Description of toolbar ................................................................................ 27

4. **Basic settings** .................................................................................................. 29
   4.1 Selecting language ....................................................................................... 29
   4.2 Menu item: Settings .................................................................................... 30
   4.2.1 Setting communication options ............................................................. 30
# Table of contents

4.2.2 Other settings ..................................................................................................... 39

5 Functions and settings ......................................................................................... 43

5.1 Menu item: Group .......................................................................................... 43
5.1.1 Inserting groups .......................................................................................... 43
5.1.2 Opening group ............................................................................................ 46
5.1.3 Deleting group ............................................................................................ 48
5.1.4 Saving group data ....................................................................................... 50

5.2 Menu item: Device .......................................................................................... 52
5.2.1 Creating new device ................................................................................... 53
5.2.2 Opening device ........................................................................................... 56
5.2.3 Deleting device ........................................................................................... 60
5.2.4 Archiving device data ................................................................................ 61
5.2.5 Connecting .................................................................................................. 63
5.2.6 Setting time on device ................................................................................ 66
5.2.7 Changing device data ................................................................................ 68
5.2.8 Changing parameter information ................................................................. 69

5.3 Menu item: Parameter set .............................................................................. 70
5.3.1 Cutting ........................................................................................................ 70
5.3.2 Copying ....................................................................................................... 71
5.3.3 Pasting ......................................................................................................... 72
5.3.4 Deleting ....................................................................................................... 72
5.3.5 Downloading/updating parameters .............................................................. 73
5.3.6 Uploading parameters ................................................................................ 75

5.4 Parameter and data structure of visualization .................................................. 77
5.4.1 Parameter groups ....................................................................................... 78
5.4.2 Parameters .................................................................................................. 79

5.5 Modules .......................................................................................................... 80
5.5.1 Basic functions ........................................................................................... 81

5.6 TAPCON® 250 Short-term memory ................................................................. 84
5.6.1 Display data archive ................................................................................... 84
5.6.2 Peak/Demand ............................................................................................. 87

5.7 TAPCON® 250 Measurement archive ............................................................... 88
Table of contents

5.7.1 Event data .......................................................................................................... 88
5.7.2 Average value data ............................................................................................ 89
5.7.3 Reading event data ............................................................................................ 91
5.7.4 Reading average value memory ......................................................................... 92
5.7.5 Event/measured value overview ....................................................................... 93

5.8 Remote ................................................................................................................... 95

5.9 Description of further menu structure .................................................................. 96
5.9.1 Menu: File ........................................................................................................... 96
5.9.2 Menu: View ....................................................................................................... 100
5.9.3 Menu: Tools ...................................................................................................... 102

6 Troubleshooting ...................................................................................................... 109
List of Figures

Figure 1  InstallShield - typical installation ........................................... 17
Figure 2  InstallShield - custom installation ........................................... 18
Figure 3  Installing features ................................................................. 19
Figure 4  MR start screen ...................................................................... 20
Figure 5  Start screen - equipment selection .......................................... 21
Figure 6  Start screen TAPCON®-trolSystem ......................................... 23
Figure 7  Description of basic structure ................................................ 26
Figure 8  Toolbar with action button ...................................................... 27
Figure 9  Selecting language ................................................................. 29
Figure 10  Dialog box - communication options .................................... 31
Figure 11  Dialog box - communication selection ................................... 32
Figure 12  Automatic baud rate selection .............................................. 33
Figure 13  Defining baud rate manually ................................................ 34
Figure 14  Properties of COM port ......................................................... 35
Figure 15  Entering Init string ............................................................. 37
Figure 16  Intervals for status information and graphics display .......... 38
Figure 17  Menu bar settings ............................................................... 39
Figure 18  Path settings ................................................................. 40
Figure 19  Setting report display ......................................................... 41
Figure 20  Dialog before printing ....................................................... 42
Figure 21  Menu bar - insert group ..................................................... 43
Figure 22  Dialog box - group details .................................................. 44
List of Figures

Figure 23  In function tree - add group ................................................. 45
Figure 24  Menu bar - open group .......................................................... 46
Figure 25  Searching for folder ............................................................... 46
Figure 26  Archive integration ............................................................... 47
Figure 27  Menu bar - delete group .......................................................... 48
Figure 28  Dialog box - delete group ........................................................ 48
Figure 29  Function tree - delete group .................................................... 49
Figure 30  Menu bar - archive group data ............................................... 50
Figure 31  Dialog box - delete group ........................................................ 50
Figure 32  Dialog box - information ......................................................... 51
Figure 33  Menu bar and toolbar - create new device .................................. 53
Figure 34  Determining device data ......................................................... 53
Figure 35  Dialog box - initialization: General settings .............................. 54
Figure 36  Dialog box - initialization: Communication .............................. 55
Figure 37  Menu bar and toolbar - open device ........................................ 56
Figure 38  "Open" dialog box ................................................................. 57
Figure 39  Dialog box - archive integration ............................................. 58
Figure 40  Dialog box - edit parameters set ............................................. 59
Figure 41  Dialog box - delete device ....................................................... 60
Figure 42  Menu bar - archive ................................................................. 61
Figure 43  Dialog box - file storage .......................................................... 61
Figure 44  Menu bar and toolbar - connect .............................................. 63
Figure 45  Dialog box - select communication ........................................... 63
List of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>46</td>
<td>Window - connecting</td>
<td>64</td>
</tr>
<tr>
<td>47</td>
<td>Status information about the device</td>
<td>65</td>
</tr>
<tr>
<td>48</td>
<td>Menu bar - Set time on device</td>
<td>66</td>
</tr>
<tr>
<td>49</td>
<td>Dialog box - Set TAPCON system time</td>
<td>67</td>
</tr>
<tr>
<td>50</td>
<td>Dialog box - initializing</td>
<td>68</td>
</tr>
<tr>
<td>51</td>
<td>Dialog box - edit parameter set</td>
<td>69</td>
</tr>
<tr>
<td>52</td>
<td>Menu bar - cut parameter set</td>
<td>70</td>
</tr>
<tr>
<td>53</td>
<td>In function tree - cut parameter set</td>
<td>71</td>
</tr>
<tr>
<td>54</td>
<td>Menu bar and toolbar - download parameters</td>
<td>73</td>
</tr>
<tr>
<td>55</td>
<td>Dialog box - download parameters</td>
<td>74</td>
</tr>
<tr>
<td>56</td>
<td>Upload configuration button</td>
<td>75</td>
</tr>
<tr>
<td>57</td>
<td>Menu bar and toolbar - upload parameters</td>
<td>76</td>
</tr>
<tr>
<td>58</td>
<td>Function tree</td>
<td>77</td>
</tr>
<tr>
<td>59</td>
<td>Groups, main and sub-groups of parameters</td>
<td>78</td>
</tr>
<tr>
<td>60</td>
<td>Dialog box - change parameters</td>
<td>79</td>
</tr>
<tr>
<td>61</td>
<td>Dialog box - download data</td>
<td>81</td>
</tr>
<tr>
<td>62</td>
<td>Start and stop specifications</td>
<td>82</td>
</tr>
<tr>
<td>63</td>
<td>Context menu for selecting image format</td>
<td>82</td>
</tr>
<tr>
<td>64</td>
<td>Measurement patterns</td>
<td>84</td>
</tr>
<tr>
<td>65</td>
<td>Layout of time information</td>
<td>85</td>
</tr>
<tr>
<td>66</td>
<td>Measurements as table</td>
<td>86</td>
</tr>
<tr>
<td>67</td>
<td>Measurements as graphic</td>
<td>86</td>
</tr>
<tr>
<td>68</td>
<td>Peak/Demand</td>
<td>87</td>
</tr>
<tr>
<td>Figure</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>69</td>
<td>Event lasting less than 5 minutes</td>
<td>88</td>
</tr>
<tr>
<td>70</td>
<td>Event lasting more than 5 minutes</td>
<td>88</td>
</tr>
<tr>
<td>71</td>
<td>&quot;Tap position&quot; list function</td>
<td>90</td>
</tr>
<tr>
<td>72</td>
<td>Download dialog box</td>
<td>91</td>
</tr>
<tr>
<td>73</td>
<td>Download dialog box (average value memory)</td>
<td>92</td>
</tr>
<tr>
<td>74</td>
<td>Event/measured value overview</td>
<td>93</td>
</tr>
<tr>
<td>75</td>
<td>Display showing front plate and main screen</td>
<td>95</td>
</tr>
<tr>
<td>76</td>
<td>Menu bar - Export data to Excel</td>
<td>96</td>
</tr>
<tr>
<td>77</td>
<td>Dialog box - conversion</td>
<td>96</td>
</tr>
<tr>
<td>78</td>
<td>Menu bar and toolbar - printing</td>
<td>98</td>
</tr>
<tr>
<td>79</td>
<td>Dialog box - report control language</td>
<td>98</td>
</tr>
<tr>
<td>80</td>
<td>Print preview</td>
<td>99</td>
</tr>
<tr>
<td>81</td>
<td>Menu bar - Zoom</td>
<td>100</td>
</tr>
<tr>
<td>82</td>
<td>Toolbar - zoom</td>
<td>100</td>
</tr>
<tr>
<td>83</td>
<td>Menu bar - Firmware Uploader</td>
<td>102</td>
</tr>
<tr>
<td>84</td>
<td>Process instructions - Firmware Uploader</td>
<td>103</td>
</tr>
<tr>
<td>85</td>
<td>&quot;TAPCON®/TAPGUARD® Network Configuration&quot; dialog box</td>
<td>104</td>
</tr>
<tr>
<td>86</td>
<td>Menu bar - Firmware Uploader</td>
<td>105</td>
</tr>
<tr>
<td>87</td>
<td>Imagecreator/CopyMachine</td>
<td>107</td>
</tr>
</tbody>
</table>
## Index of Tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 1</td>
<td>Abbreviations</td>
<td>15</td>
</tr>
<tr>
<td>Table 2</td>
<td>Typographic conventions</td>
<td>16</td>
</tr>
<tr>
<td>Table 3</td>
<td>Scope of delivery</td>
<td>23</td>
</tr>
<tr>
<td>Table 4</td>
<td>Init-string basic settings</td>
<td>36</td>
</tr>
<tr>
<td>Table 5</td>
<td>Troubleshooting</td>
<td>109</td>
</tr>
</tbody>
</table>
1 Introduction

This technical file contains detailed descriptions on how to safely and correctly install and operate the product and remedy simple faults yourself.

The target group for this technical file is only specially trained and authorized specialists.

1.1 Manufacturer

The manufacturer of the product is:
Maschinenfabrik Reinhausen GmbH
Falkensteinstrasse 8
93059 Regensburg
Tel.: (+49) 9 41/40 90-0
Fax: (+49) 9 41/40 90-7001
E-mail: sales@reinhausen.com

Please contact this address or visit www.reinhausen.com if you require more information about the software and versions of this technical file.

1.2 Subject to change

The information contained in this technical file comprise the technical specifications released at the time of printing. Major changes are taken into account in a new user manual version. The document and version number of these instructions can be found in the footer.

1.3 Completeness

This technical file is incomplete without the supporting documentation.
1.4 Supporting documentation

The quick reference guide, the operating instructions and the accompanying connection diagrams also apply in addition to this technical file. All documents are part of the scope of delivery.

Also note the generally valid, statutory and other binding regulations in European and national legislation and the accident prevention and environmental protection requirements of your own country.

1.5 Storage site

This technical file and all supporting documentation must be kept to hand and accessible at all times for subsequent use.

1.6 Illustration conventions

This section contains an overview of the abbreviations, symbols and textual emphasis used.
## 1.6.1 Abbreviations used

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD</td>
<td>Compact Disc</td>
</tr>
<tr>
<td>PC</td>
<td>Personal Computer</td>
</tr>
<tr>
<td>USB</td>
<td>Universal Serial Bus</td>
</tr>
<tr>
<td>TCP</td>
<td>Transmission Control Protocol</td>
</tr>
<tr>
<td>IP</td>
<td>Internet Protocol</td>
</tr>
<tr>
<td>a/o</td>
<td>and/or</td>
</tr>
<tr>
<td>CAN</td>
<td>Controller Area Network</td>
</tr>
<tr>
<td>LED</td>
<td>Light Emitting Diode</td>
</tr>
<tr>
<td>XLS format</td>
<td>Excel Format</td>
</tr>
<tr>
<td>MB</td>
<td>Megabyte</td>
</tr>
<tr>
<td>U</td>
<td>Voltage</td>
</tr>
<tr>
<td>T</td>
<td>Time</td>
</tr>
<tr>
<td>I</td>
<td>Current</td>
</tr>
<tr>
<td>s</td>
<td>Second</td>
</tr>
</tbody>
</table>

Table 1 Abbreviations
1.6.2 Information concept

Information is designed to simplify and improve understanding of particular operational procedures. In this technical file they are laid out as follows:

Important information.

1.6.3 Typographic conventions

In this technical file typographic conventions are laid out as follows:

<table>
<thead>
<tr>
<th>Typographic conventions</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>...&gt;...&gt;...</td>
<td>Select subsequent software menu</td>
</tr>
</tbody>
</table>

Table 2 Typographic conventions
2 Installation

Once you have inserted the installation CD in your PC's disk drive and launched the setup.exe file, you can pick from 2 types of setup:

- Typical
- Custom

You can select the setup type which best meets your requirements. Both are described below.

2.1 Typical installation

If you select the "Typical" setup type, the software is installed in full.

Proceed as follows to perform the typical installation:

1. Select the "Typical" checkbox.

2. Select "Next >" button.

   The visualization software is installed in full.
3. Once the installation is complete, please continue by going to Section 2.3 “Selecting device” on page 20.

### 2.2 Custom installation

If you select the "Custom" setup type, you can select the program features which are installed.

Proceed as follows to perform the custom installation:

1. Select the "Custom" checkbox.

![InstallShield - custom installation](image)

Figure 2  InstallShield - custom installation

2. Select "Next >" button.
2 Installation

A dialog box with all features appears.

3. Click on the corresponding symbols to select the features needed.
4. If necessary select the installation path under "Change..." wählen.
5. Select "Next >" button.
   The visualization software is installed with all the selected features.
6. Once the installation is complete, please continue by going to Section 2.3 “Selecting device” on page 20.
2.3 Selecting device

Once the software has been installed, the MR TAPCON®-trol Suite can be started. The suite comprises all MR software installed on your PC.

![MR start screen]

Figure 4 MR start screen

All software installed for the respective devices can be found in the list function under "Equipment selection". Proceed as follows:

1. If necessary, select language
   - Right-click.
   - A list of all the languages available appears.
2 Installation

2. Select the corresponding device which is to communicate with the PC from the list function.

![Start screen - equipment selection](image)

Figure 5 Start screen - equipment selection

3. Select the "Execute" button.

4. The MR Suite starts the corresponding visualization.

You can undertake all other settings in the visualization.
3 Product description

The visualization serves as a link between the hardware and user. In principle all operations and settings can be undertaken in a similar way on the hardware itself.

There is therefore no direct need to use the software to assist with input.

3.1 Scope of delivery

The following components are included in the scope of delivery:

<table>
<thead>
<tr>
<th>Scope of delivery</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD visualization software TAPCON®-trol</td>
</tr>
<tr>
<td>Operating Instructions</td>
</tr>
<tr>
<td>Serial cable RS232</td>
</tr>
<tr>
<td>USB adapter + installation CD</td>
</tr>
</tbody>
</table>

Check the shipment for completeness on the basis of the shipping documents. The scope of functions of the software depends on the ordered equipment or device variant, not on the contents of this documentation.
3.2 Basic tasks of visualization software

The visualization software has the following basic tasks:

- Communication with the device
- Reading out the saved parameters and data
- Classifying and evaluating this data
- Archiving and preserving the data history (is overwritten in the module memory)
- Printing out and conversion of parameters and data into the formats PDF, XLS, BMP etc.
- Setting parameters
- Undertaking maintenance

The visualization software allows the status of remote hardware to be queried. Depending on the equipment of the TAPCON® 250, the computer can be linked with the hardware in various ways:

- Connection using 9-pole RS 232 interface
- Use of modem function
- TCP/IP communication

The visualization is a full graphics user interface for the following Microsoft operating systems:

- Windows 2000
- Windows XP
- Windows Vista
- Windows 7

The visualization can basically be split into a display section and a configuration section which can be used both online and offline.
As well as displaying the current measured values, calculated values can also be accessed in the display section. The data can either be presented in tables or if there is sufficient data in diagrams too. Once the memory content has been downloaded by the hardware during an online connection, you can view and edit the database contents in offline mode.

Parameters are presented in tables in the configuration section. Once the initialization data has been downloaded during an online connection, you can then edit or adapt this offline so that it can be transferred back to the hardware during a subsequent online connection.

When you commission the software, it contains no TAPCON® 250 entries. This includes connection settings and configurations. These should be initialized as detailed in these instructions.

Please also note the guidelines for the language selected and the communication settings for the computer you are using. In some dialogs, the software uses the standard format of the operating system such that the language settings in areas such as printing depend on the Microsoft user interface specification.
3.3 Description of basic structure

The software structure is split into 5 areas:

1. Menu bar
2. Toolbar with action buttons
3. Status bar
4. Window for displaying values
5. Function tree

Figure 7 Description of basic structure
3 Product description

All parts of the main screen can be enlarged or shrunk using the mouse as is standard in Windows. The last settings are restored when the software is restarted.

3.4 Description of toolbar

You can pick selected functions using the toolbar. To simplify and describe the control processes, a text box containing a description of the command is shown when the mouse pointer hovers above the corresponding symbol.

The bar contains the following action button:

![Toolbar with action button](image)

1. Creative device
2. Open device
3. Delete device
4. Connect with device (active = connected)
5. Download parameter set
6. Upload parameter set
7. Communication settings
8. Grafik Zoom In
9. Grafik Zoom Out
10. Grafik Gesamtansicht
11. Print data
12. Export data to Excel
13. Delete data
4 Basic settings

Once the software has been installed, the basic settings need adapting. The following sections describe how to do this.

4.1 Selecting language

You can select the language you want from all languages currently implemented in the "Language" window shown below. This is done using a list function.

Proceed as follows to select the language:

Since standard Microsoft operating system dialogs are sometimes used, the language cannot be changed in some dialogs. Such cases include:

- Setting up the printer
- Navigation when searching for directories
- Navigation when searching for files
- The manual communication interface setting

The current language set for the Microsoft operating system is used.

1. Settings > Paths > Language

![Selecting language](image)

Figure 9 Selecting language

2. Select the language you want from the list function.

3. Press the "Apply" button to confirm.
4. Confirm with OK.
The requested language is set.

4.2 Menu item: Settings

You can use the "Settings" menu item for the following settings:
• Communication
• Serial communication
• Modem
• Update
• Quick parameter download

Proceed as described in the following sections.

4.2.1 Setting communication options

The following sections describe how you can set the communication options.
4.2.1.1 Setting communication

There are 3 ways of establishing communication with TAPCON® 250:

• Serial connection (RS232) via zero modem
• Modem
• TCP/IP network connection

Proceed as follows to set the communication options:

1. Settings > Communication
   - The "Communication options" dialog box opens.

2. Select the type of communication you want.
3. Confirm with OK.
   - The communication option is set.

Figure 10 Dialog box - communication options
Once the corresponding communication mode has been selected, the following additional options apply:

**Displaying mode selection**

If you tick the "Display mode selection" checkbox, the mode selection is displayed when setting up the serial connection. Communication by modem or network is the standard mode selection.

![Figure 11 Dialog box - communication selection](image)

**Updating parameters**

The dialog asks you to update the visualization parameters with the device parameters.
4.2.1.2 Setting serial communication

You can select the COM port in the "Serial communication" tab. Regardless of whether there is a modem or network communication card present, a TAPCON® 250 can be read out via the front interface using serial communication.

Proceed as follows to select the COM port:

1. Settings > Communication > Serial communication
2. Select COM port from the list function.

   The dialog displays all known serial interfaces.

![Dialog displaying serial interface properties](image)

Figure 12 Automatic baud rate selection

The baud rate can be defined and/or established in 2 different ways. The easiest way is the automatic baud rate process, where the program always automatically establishes the baud rate before communication.

Proceed as follows to activate the automatic baud rate:

1. Tick "Automatic baud rate selection" checkbox.
2. Confirm with OK.

   Automatic baud rate selection is activated.
If you know the device baud rate, you can undertake the setting yourself. Proceed as follows:

1. Settings > Communication > Serial communication
2. If necessary remove tick from "Automatic baud rate selection" checkbox.

Figure 13   Defining baud rate manually

Regardless of the type of communication selected, you can use further options to determine which transfer properties are in place for the online connection to the TAPCON® 250.

The visualization uses the Windows "Options" settings for the respective serial interface. These settings are identical for the serial interface and modem interface. Proceed as described on the next page:
3. Select "Option" in the dialog.

The "Port settings" window opens.

Figure 14 Properties of COM port
4.2.1.3 Setting modem

Modem communication functions regardless of modem management within Windows. In principle a COM port which can be configured in exactly the same way as the serial interface is assigned to the modem (see "Serial communication" communication options). Any kind of modem can therefore be used.

- Serial standard modem
- Mobile phone using infrared
- Mobile phone using Bluetooth
- etc.

An initialization string is needed to initialize a modem for communication. The precise initialization commands (Hayes code) for this can be found in the modem manual.

Init-string basic settings:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1</td>
<td>Modem issues messages as words</td>
</tr>
<tr>
<td>X0</td>
<td>Modem only supplies the &quot;CONNECT&quot; message</td>
</tr>
<tr>
<td>L1</td>
<td>Modem volume</td>
</tr>
</tbody>
</table>

Table 4 Init-string basic settings

Proceed as follows to enter the initialization string:

1. Settings > Communication > Modem
2. Enter the initialization string in the "Init string" field (see Figure 15).
3. Confirm with OK.

The initialization string is entered.
4.2.1.4 Update

The intervals for updating status information, current tap positions and active LEDs and the graphics (display screens for "TAPCON® 250 remote screen") are preset and should not be changed.

If these intervals are to be adapted nevertheless, proceed as follows:

1. Settings > Communication > Update

![Communication options](image)

Figure 16 Intervals for status information and graphics display

2. Enter interval for status information in ms units in the "Information status" field.

3. Enter interval for graphics display in ms units in the "Remote display" field.

4. Confirm with OK.

   The intervals are entered.

Note that times for downloads cannot be reduced below a certain level due to fixed retrieval mechanisms and how the software is used. The settings made in Figure 16 cannot therefore vary beyond the limits of a fixed and specified interval.
4 Basic settings

4.2.2 Other settings

Alongside communication options, you need to define other settings. These include:

- Setting path
- Defining visualization language
- Setting report

Open the options dialog using the menu bar:

- Settings > Language/Path/Report

![Menu bar settings](image)
4.2.2.1 Setting paths

You can specify the following directories and destination folders under "Paths":

- Main directory
- Device data
- Archive
- Download

Proceed as follows to define the path:

1. Settings > Path > Paths
2. Select any directory.
3. Look for path using the button after the respective directories and define (see Figure 18).
4. Confirm with OK once all directories have been defined.

The directories are defined.
4 Basic settings

4.2.2.2 Setting report options

An explanatory option dialog for the display can be called up when producing reports. This option dialog always appears as soon as you want to perform printing.

Proceed as follows to call up the display:

1. Settings > Path > Report

![Figure 19 Setting report display](image)

2. If required, tick the "Show dialog box on options for report display" checkbox.
3. If required, tick the "Printing of parameter blocks" checkbox.
4. Confirm with OK.

The report options are set.
If you activate the "Option dialog for report display" in the report options, a dialog appears before every print operation (see Figure 20). You can change the language for report control in this dialog. The report setting languages are independent of the language settings for the visualization.

Figure 20 Dialog before printing

If you remove the selection before "Continue to display this dialog box", this report is suppressed in subsequent operations. This definition can be reversed using the menu item shown on the following screen under "Options".

The report display for parameters can also be structured using blocks, i.e. each group of parameters is listed by page in the report.

You will find a detailed description of the print function under Section 5.9.1.2 on Page 98.
5 Functions and settings

Once you have adapted the necessary options in the "Settings" menu as described in the "Basic settings" chapter, you can move onto the next sections which describe the visualization and its structure. This structure is based on the following basic categories:

- Group
- Device
- Parameter set
- Database modules

5.1 Menu item: Group

Groups are a way of creating order within the visualization. Devices and parameter sets can be combined into the respective groups.

5.1.1 Inserting groups

There are 2 ways of inserting a group - using the menu bar or mouse. If you want to insert a group or device using the menu bar, proceed as follows:

1. Group > Insert...
   - The "Group details" dialog box opens (see Figure 21).

   ![Figure 21 Menu bar - insert group](Image)
The relevant abbreviation is needed to state a description which is displayed in the index in the bottom status bar. The abbreviation is used for display purposes in the function tree structure.

2. Enter abbreviation in "Abbreviation" field.
3. If necessary enter description in "Description" field.
4. Confirm with OK.

The group is inserted.
5 Functions and settings

If you want to insert a group in the function tree, proceed as follows:

1. Right-click in the function tree.

2. Select "Add group". wählen.
   
   The "Group details" dialog box opens (see Figure 22).

3. Enter abbreviation in "Abbreviation" field.

4. If necessary enter description in "Description" field.

5. Confirm with OK.
   
   The group is added.
5.1.2 Opening group

If you have inserted groups, you can read in group data which has been saved in a directory.

Proceed as follows to display the group data:

1. Group > Open...

   ![Menu bar - open group](image)

   The "Search for folder" dialog box opens.

2. Select the corresponding group directory.

3. Confirm with OK.

   ![Searching for folder](image)

   The "Archive integration" dialog box opens.
The group data is displayed in the "Archive integration" dialog. Alongside the current groups, you can also select groups and parameter sets.

Once you have clicked on the "Integrate" button, the selected data is transferred into the visualization database. If devices with the same ID code and/or name already exist, the ID and device name are automatically changed.
5.1.3 Deleting group

You can delete the groups you have previously created at any time. There are 2 ways of deleting a group - using the menu bar or mouse. If you want to delete a group or device using the menu bar, proceed as follows:

1. Highlight group which is to be deleted in the function tree.
2. Group > Delete

When you delete a group, all the devices and data belonging to this group are also deleted. We would therefore recommend archiving the data before deleting a group.

1. Highlight group which is to be deleted in the function tree.
2. Group > Delete

- The "Delete..." dialog box opens.

3. Select the "YES" button.

- The group requested is deleted.
If you want to delete a group or device using the mouse, proceed as follows:

1. Highlight group which is to be deleted in the function tree.
2. Right-click.

3. Select "Delete group".
   → The "Delete..." dialog box opens.
4. Select the "YES" button.
   → The group requested is deleted.
5.1.4 Saving group data

The software allows both group data and device data to be saved. This function is identical to the "Save device data" function. You receive a compressed ZIP file. This file is saved in the archive directory.

Proceed as follows to save the group data using the menu bar:

1. **Group > Archive**
   - The "File storage" dialog box opens.

2. If necessary state the directory to which the file is to be saved.
5 Functions and settings

3. Enter any name for the file in the "File name" field.
4. Select "Save" to save.
   The "Archive information" dialog box appears.

5. Confirm with OK.
   The file is saved in ZIP format.
5.2 Menu item: Device

There are 2 ways of adding a TAPCON® 250 into the visualization software:

- Download device data
- Import data from a file (Zip file)

The steps required for these 2 procedures are shown in the sections below.

If you want to produce or add a new system, you need to distinguish between groups and devices:

Groups are used to combine several devices in the sense of a directory or folder. Individual parameter data records are saved under the devices.

Each TAPCON® 250 has a code, known as an Identcode. The software uses this code to distinguish devices when establishing a connection. You can change this code at any time either directly on the TAPCON® 250 or using the visualization software. Several devices cannot however be created with the same code.

If you want to change the code on the controller directly, please read the operating instructions for the TAPCON® 250.

When the mouse pointer hovers over a device entry or parameter data record, the associated code is shown.
5 Functions and settings

5.2.1 Creating new device

You can create the new device you want using the menu bar or the toolbar. If you want to create the device using the menu bar, proceed as follows:

- Device > New

Or using the toolbar:

- Select "Create device" button from toolbar.

The "Determine current device data" dialog box opens.

The software automatically determines the basic configuration, parameter and module data.
If the software cannot assign a device after establishing a connection (see Section 5.2.2) and automatically retrieving the device-specific information or if it is not already available in the visualization database, it is read out automatically.

The download process can be shortened if the quick parameter download is activated in the communication options.

After the download process, the basic details for the TAPCON® 250 and the associated parameter set can be provided.

The following general data can be found in the "General settings" window:

- Name
- Location
- Device name
- Identcode (controller code)
The user is free to select this Identcode. The Identcode must consist of a combination of digits and may have a maximum length of 4 characters. It is also used to further describe the TAPCON® 250 in the function tree. It is shown both in the status bar and in the right-hand overview window (central window of main screen).

In contrast, the user is free to select entries for "Location" and "Description" and these are used to differentiate between different TAPCON® 250. These are shown both in the status bar and in the right-hand overview window.

In addition to the general settings, the communication options can also be defined. The visualization can use the communication options to establish the connection. These details only serve as guidelines. They do not affect the visualization and device settings.

Figure 36  Dialog box - initialization: Communication
5 Functions and settings

5.2.2 Opening device

The "Open" function allows archived (zipped) groups and devices to be inserted into the visualization. You can also insert devices using TAP files.

You can set the device you want to create using the menu bar or the toolbar.

If you want to open the device using the menu bar, proceed as follows:

1. Device > Open

Or using the toolbar:

1. Select "Open device" button from toolbar.

Figure 37 Menu bar and toolbar - open device

The "Open" dialog box opens.
2. Select zip archive.

Figure 38  "Open" dialog box

The "Archive integration" dialog box opens.
If you select a zip archive, you can determine which archived devices you want to integrate. The table shows the group/Identcode and under this the brief description of the parameter set. Devices can also be inserted without the associated data.

If the "Integrate devices automatically" option is not used, the user must provide the general details. A check is run to establish whether the Identcode is present and whether the device name has already been issued.

During initialization, i.e. when adding new TAPCON® 250, the settings undertaken can be changed in any way later on.
Once the device information has been created, the information for the associated parameter set is defined.

![Edit parameter set dialog box](image)

**Figure 40** Dialog box - edit parameters set

If you insert a parameter set as a TAP file, you perform these steps in the same order.
5.2.3 Deleting device

You can use the "Delete device" function to remove individual devices from the initialization structure. You can remove the device using the menu bar or the toolbar.

To delete a device group or an individual device using the menu bar, proceed as follows:

1. Highlight the device which is to be deleted in the function tree.
2. Device > Delete

Or using the toolbar:

2. Select the "Delete device" button.
   → The "Delete..." dialog box opens.

3. Select the "YES" button.
   → The requested device is deleted.

When you delete a device, all the associated information about the device is deleted. We would therefore recommend archiving the data before deleting a device.

Figure 41 Dialog box - delete device
5 Functions and settings

5.2.4 Archiving device data

The software allows device data to be saved. This function is identical to the "Save group" function. You receive a compressed ZIP file. This file is saved in the archive directory.

Proceed as follows to save the device data using the menu bar:

1. Device > Archive.
   ➔ The "Open" dialog box opens.

   Figure 42 Menu bar - archive

2. Open file which is to be saved.
   ➔ The "File storage" dialog box opens.

   Figure 43 Dialog box - file storage

3. State the directory to which the file is to be saved.
4. Enter any name for the file in the "File name" field.
5. Select "Save" to save.
6. Close dialog box with "Finish".

The file is saved in ZIP format.

You can insert archive files using the "Device > Open" menu item (see Section 5.2.2).
5 Functions and settings

5.2.5 Connecting

You can establish the connection to the device using the "Connection" button in the toolbar or using the menu bar.

Proceed as follows to establish the connection using the menu bar:

1. Device > Connect

Or using the toolbar:

1. Select the "Connection with device" button.

The "Select communication" dialog box opens.

Figure 44 Menu bar and toolbar - connect

Figure 45 Dialog box - select communication
A connection can be established if you have correctly undertaken the communication settings and if you know the device communication options:

2. Select the "Connect" button.

The connection to the device is established.

Once you have installed the software, the "Automatic baud rate selection" is activated for communication. COM1 has been preselected as the communication interface. You can however change the settings at any time.

Using the automatic speed query, starting at 115,200 bauds, the PC software tries to query all possible speeds down to 9600 bauds without you needing to know the baud rate set on the TAPCON® 250. The baud rate currently set is saved within the software and used as a guideline for active "Automatic baud rate selection". This guideline is extended if the connection does not come about using the speed search described. The following window ("Connect...") opens:

![Window - connecting](image)

Figure 46 Window - connecting

Once the baud rate has been established, the visualization software automatically initiates querying of the device data.
If the visualization has connected with a device, you receive status information as in Figure 47.

![Figure 47](image_url)

**Figure 47** Status information about the device

1. Connection exists (yes/no)
2. Enter password (yes/no)
3. Last 4 digits of serial number of TAPCON® 250
4. LED status indicator (if there is a connection)
5. Current level
5.2.6 Setting time on device

If you are connected to a TAPCON® 250, you can change the date and time on the device.

To set the time and date, proceed as follows with the aid of the menu bar:

1. Device > Set time on device

Note possible time shifts in devices in other time zones.
The "Set TAPCON system time" dialog box opens.

2. Define date under "Device time" list function.
3. Define time under "Device time".
4. Select "Set" button (see Figure 49).
   The changes are sent to the device.
5 Functions and settings

5.2.7 Changing device data

If you want to change the name of the device or move the device into another group for example, you can change the settings for the newly inserted voltage regulator in any way later on. There is a systematic division here with regard to assignment to groups or directories and to TAPCON® 250.

Proceed as follows to change the device data:

1. Highlight directory in middle window. The "Change description.." button appears in the bottom part of the window.

2. Select the "Change description..." button. wählen. The "Initializing" dialog box opens.

![Dialog box - initializing](image)

Changing the data stated here only relates to the structure within the visualization. The structure of the data in TAPCON® 250 is not changed.

3. Change device data.
4. Confirm with "Finish".

The changed associations are saved in the software.
5 Functions and settings

5.2.8 Changing parameter information

If you want to change the name of the parameter set, the location or the description for example, you can change them later in any way you want.

Proceed as follows to change the parameter information:

1. Highlight parameter set in middle window.
   - The "Change description.." button appears in the bottom part of the window

2. Select the "Change description..." button. wählen.
   - The "Edit parameter set..." dialog box opens.

Changing the data stated here only relates to the structure within the visualization. The structure of the data in TAPCON® 250 is not changed.


4. Confirm with "Finish".
   - The changed associations are saved in the software.

Figure 51 Dialog box - edit parameter set
5 Functions and settings

5.3 Menu item: Parameter set

As soon as systems have been fully added to the existing structure on the computer, they can be duplicated, moved or deleted again using the main and context menu. These functions are described in detail below.

5.3.1 Cutting

All selected objects are moved into the interim storage. This includes the module data. There are 2 ways of cutting the parameter set.

To cut the parameter set with the aid of the menu bar, proceed as follows:
1. Highlight parameter set in function tree.
2. Parameter set > Cut.

![Menu bar - cut parameter set](image)

The parameter set is cut and can be pasted somewhere else if required.
To cut the parameter set directly in the function tree, proceed as follows:
1. Highlight parameter set in function tree.
2. Right-click.
3. Select “Cut”.

The parameter set is cut and can be pasted somewhere else if required (for pasting, see Section 5.3.3).

5.3.2 Copying

Visible markings, parameters and configurations are copied to the computer’s interim storage for further use free from historical measurements. The original data is not affected by the following steps.

If you want to copy the parameter set, this function is identical to the “Cut” function (see Section 5.3.1):
1. Highlight parameter set in function tree.
2. Parameter set > Copy

The parameter set has been copied into the computer’s interim storage and can be pasted somewhere else if required (for pasting, see Section 5.3.3).
5.3.3 Pasting

All entries in the computer's interim storage are pasted along with the associated files at the location or group you select.

Proceed as follows to paste the entry into the desired location:

1. Highlight the location where the entry is to be pasted.
2. Parameter set > Paste

The entry is pasted at the location you want.

5.3.4 Deleting

If you delete a group, device or parameter data record, any files and structures related to the elements are deleted from the computer's hard disk along with the visible entries.

Proceed as follows to delete an element:

1. Highlight the element in question (group, device, parameter data record).
2. Parameter set > Delete

The element selected is deleted.
5 Functions and settings

5.3.5 Downloading/updating parameters

This semi-automatic function is explained in the previous sections. You can also update the parameters in the visualization directly using the menu bar or toolbar. An update is required if you are connecting the visualization to the device.

Once the parameters have been updated, the parameter visibilities are also aligned. Once the current TAPCON® 250 parameters have been downloaded, those parameters which differ from the parameters saved in the visualization are displayed in the update dialog (see Figure 55). Identical parameters are not displayed. You can download the parameters using the menu bar or toolbar.

Proceed as follows to update and download the parameters using the menu bar:

- Parameter set > Download

Or using the toolbar:
- Select the "Download" button.

![Parameter set and Settings](image)

Figure 54 Menu bar and toolbar - download parameters

The "Download parameters ..." dialog box opens.
The data is updated automatically.

Figure 55  Dialog box - download parameters

The device parameters are updated.
5 Functions and settings

5.3.6 Uploading parameters

Once all the parameter changes are complete, the updated data can be collected and transferred to the TAPCON\textsuperscript{®} 250 during online communication. As well as the menu bar and toolbar, the "Upload configuration..." button which is located in the bottom left part of the parameter screen can also be used for this purpose.

You can transfer the parameters using the menu bar or toolbar.

![Upload configuration button](image)

Figure 56 Upload configuration button

Proceed as follows to upload the parameters using the menu bar:

- With regard to parameter redundancy, the current device parameters are adopted by the respective parameter set. Parameters not selected and therefore not transferred are aligned with device values.

- When you upload the parameters, log files are created in the device directory and these log the parameter transfers.
1. Parameter set > Upload

Or using the toolbar:

1. Select the "Upload parameter set" button.

Figure 57 Menu bar and toolbar - upload parameters

- The "Upload parameters ..." dialog box opens.
- The data is compared with the software parameters to be transferred.

After the upload, there is another alignment to check whether the selected parameters have been adopted.
5.4 Parameter and data structure of visualization

Alongside the menu, the function tree is the most important element of the visualization:

![Function tree diagram]

- Device group, collection of several devices
- Device entry (location, description)
- Parameter set with parameter structure
- Device parameter for operating on on-load tap-changer; structure is exactly the same as the menu structure in the device (first 3 menu items)
- Evaluation and monitoring modules
- Current screen on device

Figure 58 Function tree
5.4.1 Parameter groups

Just as you can change parameters on the device itself, the visualization also allows you to do this. The structure in which the parameters are displayed is based on the device-specific guidelines.

The main and sub-groups of the parameters can be selected using the function tree and group table. These parameter groups are adopted when reading out device data and basically correspond to the division of groups within devices.

If you select a main group entry, the associated parameter groups are displayed in the table area on the right-hand side.

![Figure 59 Groups, main and sub-groups of parameters](image)

1. Function tree
2. Device-specific details
3. Table showing parameter groups and parameters

If you select a sub-parameter group, the display switches to displaying the respective group parameters in tabular form. TAPCON® 250
5 Functions and settings

5.4.2 Parameters

Once you have selected a parameter group, the parameters belonging to this group appear in the table display. You can change the parameter selected by double-clicking or using the "Change parameters..." button.

The parameters can only be changed in line with their specification (e.g. min. max). These parameter limits are checked during input.

The "All parameters" item also allows the parameter values saved in the groups to be displayed in one common list.

![Figure 60 Dialog box - change parameters](image)

Checks are not undertaken within the visualization to establish whether the parameters are correct for the particular system configuration. The values may only vary within the stated limits. The entries are monitored, i.e. an error message is produced if the current value entered is not in the defined range. All further actions, other than a correction, are prohibited.
5.5 Modules

Depending on device and optional equipment, the TAPCON® is fitted with a database memory where data records relating to the on-load tap-changer insert and motor-drive unit operating values are saved.

This information is saved as the following modules in the visualization.

- TAPCON® 250 Short-term memory
- TAPCON® Measurement archive
- Remote display and remote control
5.5.1 Basic functions

The individual basic functions are described in detail in the following sections.

5.5.1.1 Downloading data

Once the device-specific module and database information for the TAPCON® 250 has been created and read out, the data can be downloaded.

1. Parameter set > Modules
2. Select the "Download" button.

The data is downloaded.
5 Functions and settings

5.5.1.2 Selecting data

Once the data has been aligned, the data for the evaluation is prepared and displayed. Depending on the data basis, measured values are selected and assigned to the axes using list boxes. Adapt the time period using start/stop details to evaluate a particular time period. Date and time details which come before or after the recording period are not permitted in the selection.

![Start and stop specifications.](image)

5.5.1.3 Saving graphic data as BMP and WMF

All diagrams can be exported as image files.

Proceed as follows to export a diagram:

1. Select the diagram you want.
2. Right-click.
   - A context menu opens.

   ![Context menu for selecting image format](image)

3. Select image format required from context menu (see Figure 63).
   - The image file is copied to the computer's clipboard.

The diagram can be inserted in an image processing program or for further editing or used directly in an MS Word document.
5 Functions and settings

5.5.1.4 Deleting module data

You can delete the respective database at any time within a module display. All data and information for this module database is deleted within the visualization but not on the device.

Proceed as follows to delete module data:

2. Select the "Delete data" (waste bin) button from the toolbar.
   → The "Delete" dialog box opens.
3. Confirm with "Yes".
   → The module file is deleted.
5.6 TAPCON® 250 Short-term memory

The "Short-term memory" module contains the following tabs:

- Data archive
- Peak/Demand
- Table
- Graphic/diagram

The TAPCON® 250 short-term memory relates to the last 1,000 values which corresponds to a time basis of up to 15 minutes. The voltage and tap positions are saved. Alongside voltage patterns, the TAPCON® also saves all peak and demand values.

5.6.1 Display data archive

All measurement patterns downloaded from the voltage regulator are saved by the visualization and can be displayed again later on.

The measurement patterns saved are displayed in tables. The start and stop time and the number of measurement points are displayed. The names used in the "Measurement" column provide information about the corresponding end point for the measurement cycle.
Proceed as follows to display the values in the form of a table or diagram:

1. Double-click to select the data record you want.
2. Select the corresponding tab to switch to a "Table" or a "Graphic/diagram".

The voltage regulator's internal memory for saving the current measurements contains 1,000 items of data and is based on the current local time. These measurements are used as the basis for scaling the x-coordinates.

The call-up is started as soon as the data has been downloaded:
Select "Download" button (see Figure 66 and Figure 67).
The diagram is automatically drawn and the table is automatically filled with values. You can use the corresponding tabs to switch between table and "Graphic/diagram".

5.6.2 Peak/Demand

As well as displaying the last 1,000 voltage regulator values, the short-term memory also contains details relating to demand metering and peak values.

The displayed values can only be depicted and updated once a communication connection has been established.

Once communication is in place, all the short-term memory's data can be downloaded at any time.
5.7 TAPCON® 250 Measurement archive

The measurement memory for the TAPCON® is an optional module. The average value/events memory module contains the following tabs:

- Data archive
- Peak/Demand
- Table
- Graphic/diagram

The TAPCON® 250 stores the following data:

5.7.1 Event data

If the set voltage limit values are exceeded, high-resolution data is saved. In principle, recording starts 10 seconds before and ends 10 seconds after the threshold value is exceeded in each case. The duration of the high-resolution recording is however limited to a maximum of 5 minutes. The two diagrams below clearly show this limitation. The high-resolution areas are marked in red and the normal resolution areas in blue.

![Figure 69 Event lasting less than 5 minutes](image1)

![Figure 70 Event lasting more than 5 minutes](image2)
5 Functions and settings

While Figure 69 shows in full an event lasting less than 5 minutes, Figure 70 splits up events lasting more than 5 minutes. Here the first area in which the limit value is exceeded has been recorded in full with the 10 second lead time. Once the 5 minutes have been exceeded, the recording is however aborted automatically. Only when the value falls back below the set set threshold value is recording restarted with a lead time and follow-up time. An event lasting longer than 5 minutes is therefore split into 2 events displayed separately.

5.7.2 Average value data

The voltage regulator determines the voltage and complex current over an averaging period. This can be set by the user in the menu:

- Configuration > Memory.

Based on the basic data, the following values may be displayed in the graphic depending on the time:

- Voltage U
- Tap position
- Active current IWirk
- Reactive current IBlind
- Active power P
- Reactive power Q
- Apparent power S
- Power factor cos Phi
Proceed as follows to display this data:

- Select the data required in the "Tap position" list function below.

Figure 71 "Tap position" list function

The 4 power and power factor data types are calculated from the voltage and complex current and from the basic voltage regulator configuration with regard to the mains type and converters used.

Given the high volumes of data involved, the results of the average value memory are simply presented in graphic form, but not as a table.
5 Functions and settings

5.7.3 Reading event data

You can proceed as follows to read event data:

- Select "Read event memory" button.

or

- Select button in the "Event/measured value overview" tab.

The download time can be reduced by narrowing down the start event and the subsequent number of events. To do this you need to remove the "tick" from the checkbox before the "download completely" entry (see Figure 72).

![Download dialog box](image)

Figure 72 Download dialog box

You can also define whether the recorded event data is to be loaded into the visualization software as a copy or whether the data is to also be removed from the voltage regulator memory.

Once the data has been downloaded, the data relating to events is located in the "Eventfiles" table. Each row in this table stands for one recorded event. Double-clicking on an entry in this table displays the corresponding recorded measurement in a diagram.
5.7.4 **Reading average value memory**

Given the amount of data involved and the density of compression, it may take a long while to download the complete memory contents.

![Download dialog box (average value memory)](image)

You can however use the dialogs shown in Figure 73 to reduce the time required:

1. Remove tick from "download completely" checkbox.
2. Enter start date and time of the download under "Start".
3. Enter stop date and time of the download under "Stop".
   - The download time's limitation is set.

---

Given the high volumes of data involved, the results of the average value memory are simply presented in graphic form, but not as a table.
5 Functions and settings

5.7.5 Event/measured value overview

When you select the “Download overview” button (see Figure 74), downloading of the overview diagram starts. This diagram shows the maximum and minimum voltage values over the voltage regulator’s entire measurement interval.

The interval between 2 values in the overview diagram is 40 minutes. This value cannot vary.

The "Events" table above the diagram area shows how many and which events were recorded during this measurement period. In this context, we would refer you to the hardware operating instructions for the number of events which can be stored in the voltage regulator. As soon as this event memory is full, the last 10 events are deleted. This frees up memory space again. But all downloaded events remain in the visualization.
You can read all events as follows:

- Select "Read all event measurements" button.

A display or evaluation is undertaken after the download using the "Data archive" tab.

In order to perform this process, the overview diagram must first be read in using the "Download overview" button.
5 Functions and settings

5.8 Remote

The current displays for the TAPCON® 250 are read out in the remote display and shown within the framework of a diagrammatic front plate.

The progress bar helps in judging how up-to-date the display content and LED status are. Once the preset interval between 2 image alignments has lapsed, the display content is automatically downloaded and the LED status queried. Before the transfer starts, the progress bar is reset and the progress displayed.

Figure 75 Display showing front plate and main screen

All the front plate buttons shown can only be operated by means of a single mouse click, i.e. several buttons cannot be operated at the same time. The "Button click" is transferred between the display content alignment.
5 Functions and settings

5.9 Description of further menu structure

5.9.1 Menu: File

5.9.1.1 Converting values into XLS format

In principle all values recorded can be converted into a format compatible with MS Excel.

If the modules contain diagrams and tables, this information can be converted into Excel format (XLS). The conversion process can be undertaken using the menu bar or toolbar.

Proceed as follows to undertake conversion via the menu bar:

1. File > Export data to Excel

Or using the toolbar:

1. Select "Export data to Excel" button.

[Figure 76 Menu bar - Export data to Excel]

The "Conversion" dialog box opens.

[Figure 77 Dialog box - conversion]
2. Enter name and storage location.
3. Click on the “Conversion” button.
   ⇣ The process is complete.
5.9.1.2 Printing

As is typical for Windows, the print functions are in the two menu elements - the menu bar and toolbar.

Proceed as follows to undertake the print function via the menu bar:

- File > Print…

Or using the toolbar:

- Select "Print data" from the toolbar.

The printer can either be set with the aid of the control panel (Microsoft operating system) or using the visualization software.

The print function can basically be performed for 2 areas:

- Parameters and configuration data
- Graphics and tables of values

Depending on the area of the visualization software selected (module data, parameters etc.), the print symbol and/or function are active or inactive. The printing of parameter data is started automatically if there is no defined print function in areas.
Once you have selected the "Display" button, the print preview appears (see Figure 80).

Figure 80  Print preview

1  Start printing process
2  Zoom function for print view
3  Select page to be displayed
4  Close print preview

The corresponding table and/or graphics are printed depending on the current display. If there is no print function provided for a display, the print function of the parameters of the parameter record currently selected is automatically activated.
5 Functions and settings

5.9.2 Menu: View

If you are in a graphic window when evaluating the data, you can zoom in on or zoom out from parts of the graphs. You can activate the zoom in/zoom out function using the menu bar or toolbar.

Proceed as follows to zoom in/out using the menu bar:

- View > Whole Graphic/Zoom In/Zoom Out

![Figure 81 Menu bar - Zoom](image)

Proceed as follows to zoom in/out using the toolbar:

- Select "Zoom In"/"Zoom Out"/"Total graphic view" from the toolbar.

![Figure 82 Toolbar - zoom](image)

Alongside these menu items, you can also select an area you want to zoom into using the mouse as standard in Windows. Proceed as follows:

1. Place mouse pointer on the position you want in the graphic.
2. Hold down left mouse key.
3. Drag window from top left to bottom right.
   - A negative window opens.
4. Release left mouse key.
   - The area selected is zoomed into.
5 Functions and settings

The magnifying glass symbol in the toolbar can be used to reduce the size of the graphic. Alternatively you use the mouse to draw a negative window Proceed as follows:

1. Place mouse pointer on the position you want in the graphic.
2. Hold down left mouse key.
3. Drag window from top right to bottom left.
   \[\rightarrow\] A negative window opens.
4. Release left mouse key.
   \[\rightarrow\] The area selected is viewed smaller.

The visualization automatically ensures tracking of axis scaling.

You can move the curves shown in the graphic manually as you wish. Proceed as follows:

1. Place mouse pointer on the position you want in the curve.
2. Press and hold down right mouse key.
3. Move curve in any direction.
4. Release right mouse key.
   \[\rightarrow\] The curve is moved.

The line of the curve can be extended beyond the limits of the area you have zoomed into.
5.9.3 Menu: Tools

5.9.3.1 Updating device firmware

The visualization software allows you to update the device software for the TAPCON® 250 using online communication. The communication settings used for a regular online connection are needed in this instance.

If the H86 file to be transferred is in the device directory on the corresponding device, the firmware upload is undertaken using the menu bar as follows:

1. Tools > Firmware Uploader

The "Process instructions" dialog box opens (see Figure 84).
2. Connect PC and voltage regulator to RS232 interface with uncrossed 9-pin cable.

3. Disconnect voltage regulator from power supply.
   - The voltage regulator is switched off.

4. Hold down AUTO key and MANUAL key at the same time.

5. Connect voltage regulator to power supply.
   - The voltage regulator is switched on.

6. Release AUTO key and MANUAL key again.

7. Select the "Connect" button in the "Process instructions" dialog box.
   - Data transfer starts.

You can follow the transfer's status on the progress bar.
5.9.3.2 Setting Network-config

The Network-Config program is used to configure the Ethernet module on the SIC card of the TAPCON® 250. You can use the program to change the following:

- IP address
- Port
- Gateway address
- Subnet mask of Ethernet module

You can also read the complete settings and depending on delivery condition, initialize the module with an individual IP address.

The Ethernet module is supplied without a fixed IP address if the customer does not specify an address. To assign a fixed address to the module, you can assign an IP address via the menu bar.

Proceed as follows to assign a fixed IP address via the menu bar:

1. Tools > Network-Config

   The "TAPCON®/TAPGUARD® Network Configuration" dialog box opens.

   ![TAPCON®/TAPGUARD® Network Configuration dialog box](image)

   Figure 85 "TAPCON®/TAPGUARD® Network Configuration" dialog box
2. Select "First Initialization".
   ➔ A new window opens.

3. Select the device type under "Select Device".

4. Enter the corresponding address under "MAC address".

5. Select "Initialize" button.
   ➔ The PC initializes the Ethernet module.

6. Enter any IP address under "IP address".
   During initialization a command window containing a ping request opens.
After initialization a status window appears on your screen. This contains information on the success of the initialization. You can then close the window and change the Ethernet module settings.

Proceed as follows:

1. Select the "Close Frame" button.
   - The "First Initialization" window is closed and the original screen is displayed.

2. Enter the current IP address in the "Change Settings" > "New IP:" input mask.

3. Enter the current port in the "Change Settings" > "New port" input mask.

4. Select "Send Configuration" button.
   - The data is sent to the Ethernet module and logged in the log window.

All the Ethernet module settings can be read using the "Read Configuration" button (see Figure 85). Proceed as follows:

- Select "Read Configuration" button.
  - The data is read and logged in a log window.

The remaining values can be changed without any knowledge of the current setting.

Each of these values, apart from the MAC address, can be changed using the configuration software. The other values are fixed settings which must not be changed.
5.9.3.3 Imagecreator

The Imagecreator/CopyMachine allows you to fully back up the device firmware and data.

Proceed as follows to back up the device firmware and data:

1. Define corresponding COM interface and baud rate.
2. Confirm with "Connect".
3. Select "Receive data" to perform the backup.

The device firmware and data is completely backed up.

The "Close" button must be pressed to close the Imagecreator after the backup.
6 Troubleshooting

If faults arise during operation on the visualization TAPCON-trol® System, you will be able to resolve most of them yourself. The table below should offer you help in detecting and remedying problems.

<table>
<thead>
<tr>
<th>Error</th>
<th>Characteristic</th>
<th>Detail</th>
<th>Cause</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>No communication possible</td>
<td>Communication between visualization and device not possible.</td>
<td>Software</td>
<td>Settings incorrect.</td>
<td>Check communication interface and COM port settings under &quot;Tools&quot; and &quot;Communication&quot;. Check defined transfer rates to determine whether the transfer rates within the software and on the monitoring system are identical.</td>
</tr>
<tr>
<td>Hardware</td>
<td>Incorrect connection cable used.</td>
<td>Software</td>
<td>Settings incorrect.</td>
<td>Check whether an uncrossed 3-pole RS232 cable with 9-pole connector socket (included in scope of delivery) is actually being used in the event of a serial connection.</td>
</tr>
<tr>
<td>Monitoring of function</td>
<td>Interrupt to communication due to self-monitoring of device's monitoring systems.</td>
<td>Software</td>
<td>Settings incorrect.</td>
<td>Set communication to &quot;Offline mode&quot; and wait 30 seconds until the device is again ready for communication.</td>
</tr>
<tr>
<td>Parameters cannot be changed</td>
<td>Change protection</td>
<td>Change protection can block unauthorized parties from accessing parameters and configuration data.</td>
<td>Change protection can block unauthorized parties from accessing parameters and configuration data.</td>
<td>This function is deactivated by entering a code. Values with protection from change are only possible using visualization software.</td>
</tr>
<tr>
<td>Message: &quot;Not all values have been transferred correctly!&quot;</td>
<td>Error message in visualization</td>
<td>Software</td>
<td>Problems have arisen during the parameter comparison after uploading.</td>
<td>You will find information about these parameters in the LOG file for the transfer process. Archive device data. Delete device in visualization and create anew. If the problem persists, please get in touch with the service team.</td>
</tr>
<tr>
<td>Incomplete print-outs</td>
<td>No diagrams or tables on the printed page.</td>
<td>Printer/driver problem</td>
<td>Printing problems have been experienced in some Hewlett-Packard printers.</td>
<td>Update driver for printer in question. For further information, please go to the Hewlett-Packard website <a href="http://www.hp.com/software.html">http://www.hp.com/software.html</a>.</td>
</tr>
</tbody>
</table>

Table 5 Troubleshooting